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Using Basic Financial and Logical Functions
After completing this lesson, you will be able to:

· Use the PMT function to forecast loan payments.

· Calculate cumulative interest.

· Compute investment value.

· Use the IF function.

Microsoft Excel is an invaluable tool for performing financial calculations. Using basic functions, you can easily calculate the monthly payments for a loan, figure the accrued value of an investment, or set the value of a cell by comparing the values of two other cells. With advanced financial functions, it’s possible to figure the rate of return on an investment, amortize a loan or mortgage over time, or track the depreciation of an asset.

In this lesson, you use the PMT function to calculate loan payments, compute the cumulative interest paid on a loan using the CUMIPMT function, and figure the future value of a periodic investment with the FV function. Finally, you compare investment options using the IF function.

At Adventure Works, the Chief Financial Officer (CFO) is weighing the options for financing the upcoming chalet renovation. The mortgage broker has offered two possible loan scenarios, but the financial advisor suggested some short-term investments. Using Excel’s financial and logical functions, the CFO can calculate payment amounts, cumulative interest paid, and future value to determine the financing option that’s most cost-effective.

To complete the procedures in this lesson, you will need to use the file Financing.xls in the Lesson08 folder in the Spreadsheet Fundamentals Practice folder located on your hard disk.

Using the PMT Function to Forecast Loan Payments

The Payment (PMT) function calculates payments for a loan, based on a series of constant payments and a constant interest rate. The Future Value (FV) function calculates the value of an investment based on a series of constant deposits and a constant interest rate. The functions complement each other. The PMT function returns the borrower’s required payments for a loan, while the FV function shows the income that results from an interest-bearing investment or loan. The functions use similar syntax.

The PMT function requires the following syntax.


PMT(rate, nper, pv, fv, type)

The following table explains the meaning of each argument.

	Argument
	Explanation

	Rate
	The interest rate per payment period. If you are calculating monthly payments, you must divide the annual interest rate by 12. When calculating semimonthly payments, divide the annual rate by 24.

	Nper
	The total number of loan payments. If the loan is issued for a number of years and requires monthly payments, you can enter the number of payments as 12*<number of years>.

	Pv
	The present value (principal) of the loan.

	Fv
	The value of the loan after all payments are made. In general, this value is zero, and if this variable is omitted, it is assumed to be zero.

	Type
	The timing of the loan payments. If the loan payment is due at the end of the payment period, use the default value of 0. If payment is due at the beginning of the payment period, set this value to 1.


The Adventure Works CFO has narrowed her choices to two possible loans. Using the payment function, she determines the monthly payment for each loan based on the term and quoted interest rate.

In this exercise, you use the PMT function to calculate loan payments.

1
Open the Financing workbook from the Lesson08 folder in the Spreadsheet Fundamentals Practice folder.

2
On the Loans sheet, click cell B10, and on the Insert menu, click Function.

The Insert Function dialog box appears, as shown in the illustration on the following page.
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3
In the Or select a category list, click Financial.

The Select a function list displays the available financial functions.

4
In the Select a function list, scroll down, if necessary, and click PMT. Then click OK.

The Function Arguments dialog box appears.
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5
In the Rate box, click the Collapse Dialog button, click cell B6, and press Enter or click the Expand Dialog button.

6
In the Rate box, to the right of B6, type /12.

You must divide the annual interest rate by 12 when calculating a monthly payment.

7
In the Nper box, click the Collapse Dialog button, click cell B8, and press Enter or click the Expand Dialog button.

8
In the Pv box, click the Collapse Dialog button, click cell B4, and press Enter or click the Expand Dialog button.

[image: image3.png]Function Arguments

r
Py 175000

Fo

Type
= 4354.882415

Calculates the payment fo a loan based on constant payments and a constant nterest ate.

P i the present valus: the total amourt that a sries o Future payments s
warth now;

Formula esu ($4,354.88)

Help on this unction





9
Click OK.

The monthly payment of $4,354.88 appears in cell B10.

10
Copy the formula in cell B10 to cell C10.

The monthly payment of $3,485.89 appears in cell C10.
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11
Save the workbook with the current name.

Keep this file open for the next exercise.

Calculating Cumulative Interest

For tax or accounting purposes, it’s often necessary to calculate the total amount of interest paid over a series of loan payments. Excel’s CUMIPMT function performs this task for you.

The CUMIPMT function requires the following syntax.


CUMIPMT(rate, nper, pv, start_period, end_period, type)

The following table explains the meaning of each argument.

	Argument
	Explanation

	Rate
	The interest rate per payment period. If you are calculating monthly payments, you must divide the annual interest rate by 12. When calculating semimonthly payments, divide the annual rate by 24.

	Nper
	The total number of loan payments. If the loan is issued for a number of years and requires monthly payments, you can enter the number of payments as 12*<number of years>.

	Pv
	The present value (principal) of the loan.

	Start_period
	The first payment period in the calculation. The first period in a series of payments is numbered 1. The calculation can start with any period.

	End_period
	The last payment period in the calculation. This value can be any value greater than the Start_period. The value of the final period in a series is equal to the total number of payments.

	Type
	The timing of the loan payments. If the loan payment is due at the end of the payment period, use the default value of 0. If payment is due at the beginning of the payment period, set this value to 1.


tip

The CUMIPMT function is part of the Excel Analysis Toolpak. If the Analysis Toolpak is installed on your computer, it will appear on the list of Add-Ins accessible from the Tools menu. If the Analysis Toolpak is not installed, install it from the Microsoft Office XP or Microsoft Excel 2002 installation CD before continuing.

At Adventure Works, the CFO wants to compare the total amount of interest paid for each of the loans offered.

In this exercise, you activate the Analysis Toolpak and then use the CUMIPMT function to calculate total interest paid for a loan.

1
On the Tools menu, click Add-Ins.

The Add-Ins dialog box appears.
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2
On the Add-Ins available list, select the Analysis Toolpak check box, and click OK.

Excel activates the Analysis Toolpak. Its functions are now available.

3
Click cell B12, and click the Insert Function button to the left of the Formula bar.

The Insert Function dialog box appears.

4
In the Or select a category list, click Financial, if necessary.

The Select a function list displays the available financial functions.

5
In the Select a function list, click CUMIPMT, and click OK.

The Function Arguments dialog box appears.

6
Click in the Rate box and then click cell B6.

7
Click in the Rate box to the right of B6 and type /12.

8
Click in the Nper box and click cell B8.

9
Click in the Pv box, and type B4.

10
In the Start_period box, type 1.

11
In the End_period box, type 48.

This formula will calculate the cumulative interest paid over the time between the given start and end periods. In this case, you are calculating cumulative interest for the entire life of the loan, so you begin with the first payment period (1) and end with the final payment period (48).

12
Scroll down in the Function Arguments dialog box, and in the Type box, type 0.

Excel will assume that each payment is due at the end of its payment period.

13
Click OK.

The amount of interest paid over the life of loan Option A ($34,034.36) appears in cell B12.

14
Copy the formula in cell B12 to cell C12.

The amount of interest paid over the life of loan Option B ($32,555.86) appears in cell C12.
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15
Save the workbook with the current name.

Keep this file open for the next exercise.

Computing Investment Value

The Future Value (FV) function calculates the value of an investment based on a series of periodic, constant payments and a constant interest rate. The FV function requires the following syntax.


FV(rate,Nper,Pmt,Pv,Type)

The following table explains the meaning of each argument.

	Argument
	Explanation

	Rate
	The interest rate per period. If you are calculating monthly deposits, you must divide the annual interest rate by 12. When calculating semimonthly deposits, divide the annual rate by 24.

	Nper
	The total number of deposits.

	Pmt
	The amount deposited in each period.

	Pv
	The present value or lump sum amount that a series of deposits is worth now. By default, this amount is 0, and the Pmt argument is used.

	Type
	The timing of the deposits. If the deposit is made at the end of the period, use the default value of 0. If deposits are made at the beginning of the payment period, set this value to 1.


As an alternative to conventional loans, a financial advisor advised Adventure Works to fund the planned chalet renovations by investing in short-term annuities. The CFO is evaluating the future value of the investment.

In this exercise, you calculate the future value of an investment.

1
In the Financing workbook, click the Investments sheet tab.

2
Click cell B10, if necessary, and on the Formula bar, click the Insert Function button.

The Insert Function dialog box appears.

3
In the Or select a category list, click Financial, if necessary.

The Select a function list displays the available financial functions.

4
In the Select a function list, click FV, and click OK.

The Function Arguments dialog box appears.

5
Click cell B4 to insert this cell reference in the Rate box.

6
Click in the Rate box to the right of B4 and type /12.

7
Click in the Nper box and click cell B6.

8
Click in the Pmt box and click cell B8.

9
Click OK in the Function Arguments dialog box.

The future value of the investment ($125,133.70) appears in cell B10.
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10
Save the workbook with the current name.

Keep this file open for the next exercise.

Using the IF Function

Suppose you are considering a loan that offers an interest rate of 9 percent if the principal is over $20,000 or an interest rate of 10 percent if the principal is less than $20,000. Using the IF function, you can create a formula that incorporates this rule when calculating payments or interest for various principal amounts.

Using the IF function creates a conditional formula. The result of a conditional formula is determined by the state of a specific condition or the answer to a logical question.

The IF function requires the following syntax.


IF(Logical_test, Value_if_true, Value_if_false)

The following table explains the meaning of each argument.

	Argument 
	Explanation

	Logical_test
	The expression to be evaluated as true or false.

	Value_if_true
	The value returned if the logical_test expression is true.

	Value_if_false
	The value returned if the logical_test expression is false.


The Logical_test is an expression to be evaluated as true or false. One example of a Logical_test is


D5>20000

With this test, Excel compares the value in cell D5 with the static value of 20000. If the value in D5 is greater than 20000, the test is true, and the result of the formula is the Value_if_true. If the value in D5 is less than 20000, the logical test is false, and the result of the formula is the Value_if_false. Using the IF function, the syntax of one such formula is


=IF(D5>20000,0.10,0.09)

The CFO at Adventure Works has learned that the investment she is considering offers many monthly payment options with slightly different interest rates. She creates a formula to calculate the future value of her investment at various payment levels.

In this exercise, you use the IF function to evaluate the available investment options.

1
Click cell B4, and press Delete.

2
On the Formula bar, click the Insert Function button.

The Insert Function dialog box appears.

3
On the Or select a category list, click Logical.

The Select a function list displays the available logical functions.

4
In the Select a function list, click IF, and then click OK.

The Function Arguments dialog box appears.

5
In the Logical_test box, type B8<=-10000.

6
In the Value_if_true box, type 8.25%.

7
In the Value_if_false box, type 9.10%, and click OK.

The applicable interest rate (8.25%) appears in cell B4. Excel recalculates the future value of the investment.
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8
Click cell B8, type -8500, and press Enter.

Excel recalculates the interest rate, and the updated future value of the investment ($106,363.65) appears in cell B10.

Lesson Wrap-Up

In this lesson, you learned how to use Excel’s financial functions to forecast loan payments, compute the cumulative interest paid, and figure the future value of an investment. You also learned how to use the logical IF function to perform calculations based on the status of a specific condition.

If you are continuing to other lessons:

· Save your changes to the Financing workbook and close the workbook.

If you are not continuing to other lessons:

1
Save your changes to the Financing workbook and close the workbook.

2
Click the Close button in the top-right corner of the Excel window.

Quick Quiz

1
What does the CUMIPMT function compute?

2
What function can be used to compare the value of two cells?

3
What are two ways to add cell addresses to a function?

4
What are the required arguments of the PMT function?

5
What does it mean if you use the PMT function and get a negative number?

Putting It All Together

Exercise 1: Calculate the monthly payments and cumulative interest for a 20-year $100,000 loan at an annual interest rate of 8 percent. Use an IF function to indicate that the interest rate for a 30-year loan is 7.5 percent.

Exercise 2: Calculate the future value of 24 monthly payments of $500 each at an annual interest rate of 6.5 percent.

Exercise 3: Calculate the monthly payments for a $150,000, 30-year house loan at an annual rate of 6 percent. Compare this to the monthly payments on the same house with a 15-year loan at 5 percent. What is the difference in monthly payment? What is the difference in cumulative interest?

Exercise 4: Many of the tasks in this lesson involved the development of function formulas that would be useful in calculating loan values. Since the calculation of loans is such a common need for many users of Excel, there is a ready-made template available that you can use. Create a new worksheet based on this template and then explore the functions that are used within this worksheet. Which of the functions you have used in this lesson are used in that worksheet?

Exercise 5: Calculate the future value of an investment if you contribute $100 per month for the next five years in an account that earns 3 percent. Calculate the future value on an investment in which you contribute only $50 per month for five years and earn 6 percent. Which investment would be worth more at the end of the five-year period?

You don’t have to use the Collapse Dialog button to add cell addresses to a function. If you prefer, you can type them directly into the appropriate boxes of the Function Arguments dialog box or simply drag the dialog box out of the way if necessary and click in a cell to make a selection.





Because payments are assumed to be outgoing, the result of the PMT function is a negative value.





Your list of available add-ins may vary from what is shown here.





Excel includes three functions that calculate results based on conditions. The other two are COUNTIF and SUMIF.
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